This manual belongs to:
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this manual</td>
<td>3</td>
</tr>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Application</td>
<td>11</td>
</tr>
<tr>
<td>Requirements</td>
<td>17</td>
</tr>
<tr>
<td>How to install PST</td>
<td>23</td>
</tr>
<tr>
<td>How to use PST</td>
<td>33</td>
</tr>
<tr>
<td>Graphical User Interface (GUI)</td>
<td>75</td>
</tr>
</tbody>
</table>
This is the user’s manual for the Parameter Setting Tool (PST)

Document number: 1MRK 511 089-UEN

Version: 1.1

Revision: 02

Issue date: May 2001

Data subject to change without notice

We reserve all rights to this document, even in the event that a patent is issued and a different commercial proprietary right is registered. Improper use, in particular reproduction and dissemination to third parties, is not permitted.

This document has been carefully checked. If the user nevertheless detects any errors, he is asked to notify us as soon as possible.

The data contained in this manual is intended solely for the product description and is not to be deemed to be a statement of guaranteed properties. In the interests of our customers, we constantly seek to ensure that our products are developed to the latest technological standards.

As a result, it is possible that there may be some differences between the HW/SW product and this information product.

Author’s address:

ABB Automation Products AB
Substation Automation Division
SE-721 59 Västerås
Tel: +46 (0) 21 34 20 00
Fax: +46 (0) 21 14 69 18
Internet: http://www.abb.com/automation

© ABB Automation Products AB 2001
Introduction ............................................................................................................. 7
  Intended use of this manual ................................................................................. 7
  Glossary ................................................................................................................. 7
  Intended audience .......................................................................................... 8
    Responsibilities ............................................................................................... 8
  What is in this manual? .................................................................................. 9
  How to find more information ........................................................................ 9
  Service notes ...................................................................................................... 10
Introduction

1

Intended use of this manual

This manual provides information on how to install and use the Parameter Setting Tool (PST). It also specifies PC requirements and supported terminal product families.

PST is a tool for managing parameters for monitoring, service values, protection and control terminals and relays. It is a MS Windows application intended to run on a standard PC.

2

Glossary

This chapter explains some key expression and abbreviations used in this manual.

Table 1: Glossary

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Abbreviation for Bitmap - one (of many) format of a graphical file.</td>
</tr>
<tr>
<td>CAP 531</td>
<td>The programming and configuration tool used for the REx5xx series of terminals.</td>
</tr>
<tr>
<td>Compressed file</td>
<td>A file with the extension.zpt that stores all the parameter values for a terminal instance. A compressed file can be moved to another project or computer.</td>
</tr>
<tr>
<td>Level</td>
<td>Each item (folder) in the terminal tree.</td>
</tr>
<tr>
<td>LIB 510</td>
<td>MicroSCADA application software library for medium voltage.</td>
</tr>
<tr>
<td>LIB 520</td>
<td>MicroSCADA application software library for high voltage.</td>
</tr>
<tr>
<td>LON</td>
<td>Communication protocol: (Local Operating Network).</td>
</tr>
<tr>
<td>MicroSCADA</td>
<td>SCADA system from ABB.</td>
</tr>
<tr>
<td>Navigation environ-</td>
<td>The tool from which PST is started (CAP 531, MicroSCADA, etc.)</td>
</tr>
<tr>
<td>ment</td>
<td></td>
</tr>
<tr>
<td>Parameter input field</td>
<td>A field for a parameter in the Parameter view were a new value can be entered.</td>
</tr>
<tr>
<td>Parameter level</td>
<td>The leaves of the Terminal tree, were parameters are presented in the Parameter view.</td>
</tr>
<tr>
<td>Parameter Setting Tool</td>
<td>The tool this manual describes. Referred to in the text as PST or “the tool”.</td>
</tr>
<tr>
<td>Parameter view</td>
<td>The right window in the tool that shows the parameter values or information of the terminal sub-levels.</td>
</tr>
<tr>
<td>Picture function</td>
<td>Graphical element within a process picture.</td>
</tr>
</tbody>
</table>
Table 1: Glossary (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process picture</td>
<td>Graphical display used in MicroSCADA environment from the terminal navigation is made.</td>
</tr>
<tr>
<td>Product family</td>
<td>The family name for a series of terminals that PST handles as an entity, for instance REX500, CX.</td>
</tr>
<tr>
<td>PST</td>
<td>Abbreviation for Parameter Setting Tool.</td>
</tr>
<tr>
<td>SPA</td>
<td>Asynchronous ASCII communication protocol from ABB.</td>
</tr>
<tr>
<td>Terminal</td>
<td>A common name for a target unit (terminal, relay, controller, etc.) that the tool can read and write parameters to.</td>
</tr>
<tr>
<td>Terminal instance</td>
<td>A specific terminal that the parameter setting tool just is working with.</td>
</tr>
<tr>
<td>Terminal level</td>
<td>The upper-most level in the Terminal tree.</td>
</tr>
<tr>
<td>Terminal tree</td>
<td>The left browsing window in the tool that shows the structure of the terminal instance.</td>
</tr>
<tr>
<td>Terminal sub-level</td>
<td>A level in the Terminal tree between the terminal level and a parameter level.</td>
</tr>
<tr>
<td>Template</td>
<td>A template stores all parameter values for a terminal instance. A template is unique in a product family and cannot be moved to another computer. Standard templates for the product families are installed at PST installation time.</td>
</tr>
<tr>
<td>Terminal type</td>
<td>A specialization of a product family. For instance, REO517 is a terminal type in the product family REX500. Note that the tool handles product families and not terminal types.</td>
</tr>
</tbody>
</table>

3 Intended audience

This manual can be used by installers, commissioners and system engineers.

3.1 Responsibilities

In order to fully understand the contents of this manual, you should have basic engineering knowledge and specific knowledge in system automation, depending on your purpose.
What is in this manual?

This manual is organized into chapters according to the intended audience so that each chapter corresponds to the user’s needs.

Chapter 1 gives an introduction to the manual.

Chapter 2 gives an overview of PST and its contents.

Chapter 3 specifies the requirements for your PC and operative system and which product families and releases are supported by PST.

Chapter 4 describes how to install and uninstall PST

Chapter 5 describes how to use PST.

Chapter 6 describes the graphical user interface.

Chapter 7 describes system errors and messages.

How to find more information

The following manuals provide complementary information:

Reference

1  CAP 540 Terminal tool box, User’s Manual.1MRK 511 104-UEN
2  CAP 531 Configuration and Programming tool, User’s Manual.1MRK 511 105-UEN
3  HV/REx5xx 3.0 User’s Manual.1MRK 511 077-UEN
4  User’s Manual MicroSCADA * 8.4.2.
5  SMS 510 Installation and Commissioning Manual1MRS751265-MEN
6  SMS 510 Operator's Manual1MRS751267-MUM
6 Service notes

Concerning PST versions *1.1-00

No service notes for this release
Application

Parameter Setting Tool (PST) ................................................................. 13
Navigation environment ........................................................................ 13
Communication ................................................................................. 13
Application

7 Parameter Setting Tool (PST)

PST is a tool for managing parameters for monitoring, service values, protection and control terminals and relays. You can read the parameters from a terminal, edit the parameter values and write the parameter values to a terminal. You can also edit your parameters in advance and write them to the terminal when it is available.

PST is a MS Windows application intended to run on a standard PC. It can be used for a variety of terminals (product families) with the same user interface.

7.1 Navigation environment

PST is delivered as a part of the navigation environment that is selected. The supported navigation environments are CAP 540, MicroSCADA and SMS 510.

7.2 Communication

PST utilizes different ways of communicating with the terminals.

In the CAP 540 environment, communication with SPA is supported. PST does not support LON or LONMark using a LON communication card (PCLTA). See figure 1.

Communicating via MicroSCADA, SPA and LON are supported. Communication using LONMark is not supported. In the MicroSCADA environment PST can work in a distributed network of computers either on the LAN or using a RAS connection. See figure 2.

SMS 510 supports the same types of communication as MicroSCADA. See figure 3.
Parameter Setting Tool (PST)

Application

Figure 1: Communication overview in CAP 540 environment

Figure 2: Communication via MicroSCADA
Figure 3: Communication via SMS 510
Requirements

PC, operative system and help viewer

Navigation environment

CAP 540
MicroSCADA
SMS 510

Product family support
Requirements

8 PC, operative system and help viewer

Table 2: Requirements on PC

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor / Frequency</td>
<td>Pentium / 166 MHz</td>
</tr>
<tr>
<td>RAM</td>
<td>64 MByte</td>
</tr>
<tr>
<td>Disk space</td>
<td>150 MByte</td>
</tr>
<tr>
<td>Monitor / Resolution</td>
<td>VGA compatible / 800 x 600, 256 colors</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Needed to install PST</td>
</tr>
<tr>
<td>Printer</td>
<td>300 dpi</td>
</tr>
</tbody>
</table>

Table 3: Requirements on operative system and help viewer

<table>
<thead>
<tr>
<th>Operative System</th>
<th>Release</th>
<th>Help viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98 (Microsoft version)</td>
<td>with DCOM98 for Windows 98 ver 1.3</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows NT 4 (Microsoft version)</td>
<td>4.0, service pack 4 or higher</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows 2000 (Microsoft version)</td>
<td></td>
<td>Internet Explorer 4 or later</td>
</tr>
</tbody>
</table>
9 Navigation environment

9.1 CAP 540

The following product releases are needed to use PST from CAP 540:

Table 4: Requirements on CAP 540

<table>
<thead>
<tr>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP 540</td>
<td>1.1 or higher</td>
</tr>
</tbody>
</table>

9.2 MicroSCADA

The following product releases are needed to use PST from MicroSCADA:

Table 5: Requirements on MicroSCADA

<table>
<thead>
<tr>
<th>Tool package</th>
<th>Release</th>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroSCADA Base</td>
<td>-</td>
<td>-</td>
<td>8.4.3 or higher</td>
</tr>
<tr>
<td>LIB 500</td>
<td>4.0.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LIB 510</td>
<td>4.0.3</td>
<td>SPA Tool</td>
<td>4.0.3 or higher</td>
</tr>
<tr>
<td>LIB 520</td>
<td>4.0.3-1 or higher</td>
<td>HVREX 500</td>
<td>3.0 or higher</td>
</tr>
<tr>
<td>LIB 520</td>
<td>4.0.3-1 or higher</td>
<td>HVRET 521</td>
<td>3.0 or higher</td>
</tr>
</tbody>
</table>

9.3 SMS 510

The following product releases are needed to use PST from SMS 510:

Table 6: Requirements on SMS 510

<table>
<thead>
<tr>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS 510</td>
<td>1.0.0 with service pack 1</td>
</tr>
</tbody>
</table>
Product family support

The following product families and releases are supported by the tool:

Table 7: Supported product families

<table>
<thead>
<tr>
<th>Product family</th>
<th>Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REX500</td>
<td>2.0 or higher</td>
<td>The REX500 series of control and protection terminals.</td>
</tr>
<tr>
<td>RET521</td>
<td>2.1 or higher</td>
<td>The RET521 transformer protection terminal.</td>
</tr>
</tbody>
</table>
How to install PST

Install PST..................................................................................................................25
Installing the PST documentation ........................................................................29
Uninstall PST ...........................................................................................................30
PST network setup....................................................................................................31
How to install PST
How to install PST

Depending on the navigation environment, PST is installed in different ways. Whether the navigator environment is CAP 540, MicroSCADA or SMS 510, the PST is installed separately from the rest of the system. For CAP 540 please see reference [1], for MicroSCADA, please see reference [3] and for SMS 510, please see reference [5]. The installation of PST is the same for these environments and are described in instructions in this chapter.

Note!
When installing in Windows NT and Windows 2000, you need to log on as administrator.

11 Install PST

This section describes how to install PST in the basic version of CAP 540, MicroSCADA and SMS 510 environment. The full version of CAP 540 includes configuration and is installed together with PST. See reference [2] for this installation procedure.

The first steps in the installation instruction (where to find the installation file pst.exe etc.) is described in the manuals for the navigation environment, references [3] and [5] respectively. When the installation starts the following dialog appears:

Figure 4: Welcome dialog

1 Read the message and click OK if you want to continue with the installation.

The following dialog appears:
2 Select the check boxes for all terminal libraries you want to install

3 If you want to change the destination for the PST installation, click the Change button to the right of the PST destination box.

The following dialog appears.
4 Select the drive and the folder where the PST software shall be installed, and then click OK.

5 Click Next.

The following dialog appears:

![System Information dialog](image)

Figure 7: System Information dialog

6 Check the information and choose one of the following two steps:

- To reenter any information, click Back.
- To start the installation, click Install.

The PST software is now installed in your computer, showing you a installation progress bar.

7 When the installation is complete, click OK to restart your computer

After restarting your computer, you can begin using the tools and the terminal libraries in the PST software package.

The installation sets up the following program entries in the start menu under Programs\PST.
Figure 8: PST start menu

The help function in the Parameter Setting Tool uses Internet Explorer. If you do not have Internet Explorer on your computer, you have to install it.

Note!

The PST cannot be started from the program start menu. It is always started from its navigation environment: MicroSCADA, SMS 510 or CAP 540.
12 Installing the PST documentation

This section describes how to install the documentation for PST.

The first steps in the installation instruction (where to find the installation file pst-doc.exe etc.) is described in the manuals for the navigation environment, references [3] and [5] respectively. When the installation starts the following dialog appears:

![Welcome dialog](image)

**Figure 9:** Welcome dialog

1. **Read the message and click OK if you want to continue with the installation.**

   The following dialog appears:

   ![Destination dialog](image)

   **Figure 10:** Select destination drive and folder for the documentation

2. **Select the drive and the folder where the PST documentation shall be installed, and then click Next.**

   The following dialog appears:
3 Check the information and do one of the following

- To reenter any information, click Back.
- To start the installation, click Install.

The PST documentation is now installed into your computer, showing you a installation progress bar.

4 When the installation is complete, click OK.

The installation sets up documentation entries in the start menu under Programs\PST

Note!

*The documents are in pdf-format, and you need Acrobat Reader to view them*

13 Uninstall PST

There is no uninstall for the PST.
PST network setup

This section describes how to setup the network model for PST in the MicroSCADA and in the SMS 510 environment. The setup must be done for all involved computers in the network.

CAP 540 is not intended to be used as a network application. Therefore set up of network is not needed, when CAP 540 is the navigator.

1 Start the program PstNetworkSetup.exe.
You find it in the Start Menu under Programs\PST.

The following dialog appears:

![Figure 12: PST Network Installation dialog](image)

2 Under Network Model, click the appropriate button.
- Peer-to-Peer model means that computers are connected as workstations.
- NT Domain Server means that an NT Server is set up as a domain server.

3 Click Install
The network support is now installed for the network model you have selected.
PST network setup

How to install PST
How to use PST ..................................................................................................... 35

Overview ............................................................................................................ 35

Configure the navigation environment ............................................................... 36
  Configuration in CAP 540 ............................................................................. 36
  Configuration in MicroSCADA ....................................................................... 36
  Configuration in SMS 510 ............................................................................. 36

PST in network environment .............................................................................. 36

Start PST ............................................................................................................ 37
  Start from CAP 540....................................................................................... 37
  Start from the project tree ........................................................................ 37
  Start from a function block within a worksheet in CAP 531 ..................... 37
  Start from MicroSCADA ................................................................................ 38
  Start from SMS 510 ...................................................................................... 39

Customize the behavior of PST ......................................................................... 40
  Select the behavior of reading and writing of parameters............................. 40
  Set up the communication ............................................................................ 40
  Unlock terminal ............................................................................................. 42
  Change parameter values............................................................................. 42
  Open a terminal instance with default or saved values................................. 42
  Open a template ........................................................................................... 43
  Open a compressed file ................................................................................ 44
  Off-line adjustment of terminal options ......................................................... 45
  Navigate in the terminal tree ......................................................................... 46
  Change a parameter value ........................................................................... 46
  Save the parameter values ........................................................................... 47
  Work with setting groups............................................................................... 48
    Select setting group ............................................................................... 48
    Copy values between setting groups ....................................................... 49

Read parameter values from a terminal............................................................. 49
  Read options ................................................................................................. 50
  Read all parameter values ............................................................................ 50
  Read selected parameter values .................................................................. 50
  Read dialog ................................................................................................... 51
  Save last read ............................................................................................... 51

Compare tool parameter values with terminal values ........................................ 52
  Compare with terminal ............................................................................... 52
  View differences .......................................................................................... 53
  Print differences .......................................................................................... 54

Write parameter values to a terminal ................................................................. 56
# How to use PST

- Write all parameter values .................................................................56
- Write selected parameter values to the terminal..........................57

**Print parameters** .................................................................................59
  - Change the header and footer information .....................................59
    - Value Selection .................................................................................59
    - Font ..................................................................................................60
  - Print to a printer ..................................................................................62
    - Print to a printer by a menu command ...........................................62
    - Print to a printer from the tool bar ...............................................64
  - Print to a file ......................................................................................64
    - Open a printed file with Microsoft Excel .......................................65

- Save parameter values for an entire terminal instance ..................66
  - Save as a template .................................................................66
  - Save as a compressed file ..........................................................67

- Exit PST ..................................................................................................69

- Process Terminator ...............................................................................69
How to use PST

15 Overview

This chapter describes how PST is used for different operations, such as:

- changing parameter values
- handling of setting groups
- writing of the parameter values to a terminal
- reading of the parameter values from a terminal
- saving and reading the parameter values as templates (for reuse in the project)
- saving and reading the parameter values as compressed files (for reuse in other projects and computers)
- printing the parameters
- comparing the parameters in the tool with parameters in the terminal.
- monitoring
- service values

In order to use PST it must be installed in your computer, see “How to install PST” on page 25. To start PST, there must also be a terminal inserted in the navigation environment that you are using. To read and write parameter values from or to a terminal, the communication parameters must be set up, and a physical connection to your terminal must be available.

The work starts with defining an application structure in the navigation environment. After that you have to make the communication setup, e.g. enabling PST to communicate with the appropriate terminal. Then you can either read the parameter values from your terminal, define them off-line, get them from a template or get them from a saved file. When the parameter values are set, they can then be written to your terminal. Finally you can print your parameters and save them for reuse in the project (template) or reuse in other projects and computers (compressed file).
16 Configure the navigation environment

This section describes how to configure the navigation environment. In order to use PST, the navigation environment must be configured to reflect the terminal instances you have in your project or organization.

16.1 Configuration in CAP 540

To use CAP 540 as your navigation environment, the project tree in the CAP 540 must be built. In this tree, you add the terminal instances for all units for which you want to use the PST. This is described in detail in reference [1].

CAP 540 is not intended to be used as a network application. Therefore you can not use PST in a network of computers when CAP 540 is the navigator.

16.2 Configuration in MicroSCADA

To use MicroSCADA as your navigation environment, process pictures must be built that contains the picture functions for the terminal instances for which you want to use PST. This is described in detail in reference [3] and [4].

PST can be used in a network of computers when MicroSCADA is the navigation environment.

16.3 Configuration in SMS 510

To use SMS 510 as your navigation environment, the project structure must be built that includes the terminal instances for which you want to use PST. This is described in detail in reference [5].

PST can be used in a network of computers when SMS 510 is the navigation environment.

17 PST in network environment

To use PST in a network, the PST need to be installed on all involved computers, i.e. on all client computers as well as on the server computer. The installation is made during the installation of the navigation environment (SMS 510 or MicroSCADA). You need also to setup the network. See “How to install PST” on page 25 for details on installation and setting up the network.
18 Start PST

This section describes how to start PST. You can start it from the navigation environment you have installed. From CAP 540 you start the PST from the project tree or from a function block within the configuration worksheet. In MicroSCADA you start from a process picture. In SMS 510 you start from the project structure.

18.1 Start from CAP 540

18.1.1 Start from the project tree

You can start PST from the project tree in CAP 540.

1 In the project tree, select the wanted terminal instance.
2 With a right click select Parameter Settings.

PST starts for the selected terminal instance, showing the top terminal level.


Note!

For product families with currently no support for PST, the Parameter Setting command on edit menu will be disabled.

18.1.2 Start from a function block within a worksheet in CAP 531

You can start PST from a function block in the configuration tool.

1 Open a work sheet for the wanted terminal instance.
2 With the right or left mouse button, double-click the wanted function block.

The Function Block dialog appears.

3 Click Parameter Settings

PST starts for the wanted terminal instance, showing the parameter level that corresponds to the selected function block.

Note!

It is only possible to start PST from function blocks that have associated settings. For all other function blocks, the Parameter Setting button will be disabled in the Function Block dialog.

18.2 Start from MicroSCADA

You can start PST from a process picture in MicroSCADA.

1 Select the process picture with the picture function for the wanted terminal instance.

![Figure 13: Example of PST start in a MicroSCADA process picture](image)

2 Click the picture function, and then click Setting tool. PST starts, showing the top terminal level.

See references [3] and [4] for more details on the handling in MicroSCADA.
18.3 **Start from SMS 510**

You can start PST from the project structure in SMS 510.

1. **In the project structure, select the wanted terminal instance.**
   
   PST is now visible in the Object Tools list.

2. **Double-click PST in the Object Tools list.**
   
   PST starts, showing the top terminal level.
19 **Customize the behavior of PST**

This section describes how you customize some of the functionality in PST.

19.1 **Select the behavior of reading and writing of parameters**

1. **On the Edit menu, click Customize.**

   The following dialog appears:

   ![Customize dialog](image)

   *Figure 14: The customize dialog for reading and writing of parameters*

2. **Select the appropriate check boxes.**

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read back parameters after a Write to Terminal</td>
<td>The commands ‘Write to Terminal</td>
</tr>
</tbody>
</table>

19.2 **Set up the communication**

The communication is setup in the navigation environment MicroSCADA, (reference [4]), CAP 540 (reference [1]) or in SMS 510 (references [5] and [6])

You can however read how the communication is setup:

1. **On the Online menu, click Setup**

   The following dialog appears:
Customize the behavior of PST

How to use PST

2 Click OK.

The following dialog appears:

![Communication setup dialog](image)

*Figure 15: Communication setup read only message*

3 Click Configure.

The following dialog appears when your navigation environment is CAP 540:

![SPA Settings dialog](image)

*Figure 17: CAP 540 communication parameters*
When your navigation environment instead is MicroSCADA or SMS 510, the following dialog appears:

![Communication dialog for MicroSCADA and SMS 510](image)

Figure 18: Communication dialog for MicroSCADA and SMS 510

### 19.3 Unlock terminal

There is a lock in the terminal that will prevent two concurrent connections (i.e. front and backside communication) from accessing information from different setting groups. The terminal will respond with a code to indicate that the setting group is locked if a request is made to access a different setting group than the locked one.

One problem that can arise with this sort of logic is if a lock command is issued and accepted by the terminal, but the communication is interrupted before the unlock command is received by the terminal. A special unlock feature is available in the setup dialog to eliminate this problem. Simply check the Unlock box and an unlock command will be issued to the terminal the next time a communication command is issued. The checkbooks will be cleared automatically after the communication attempt.

The reason why the command is not always used is to insure safety at all times. The operator must before the checkbooks is checked be sure that no other interfering communication will be performed.

### 19.4 Change parameter values

This section describes how PST is operated in order to define new values for the parameters. How to work with setting group is also described.

Start by opening a template, by reading a compressed file or by reading the values from a terminal, or just start with the parameter values you have earlier saved for your terminal in PST. Then make your changes to the parameters, and save them in the tool. To simplify your work with several setting groups, you can also copy all parameter values from one setting group to another.

### 19.5 Open a terminal instance with default or saved values

The first time you start PST for a terminal instance, every parameter has a default value. For the definition of “terminal instance”, see the Glossary.
The next time you start PST for that terminal instance, you will get the parameter values you saved the last time you worked with it.

**Note!**

*Once you have changed parameters in a terminal instance, you cannot return to the default values for that instance. Instead you can open a template that has default values on the parameters, or, create a new terminal instance in the navigation environment that starts with the default values on the parameters.*

How you open a terminal instance from different navigation environments is described in section 18

### 19.6 Open a template

You can open a template that earlier has been saved in your project. Templates stores the setting values for an entire terminal.

1. **On the File menu, point to Template, and then click Open.**
   
   After templates are made, the following dialog appears:

   ![Open template dialog](image)

   *Figure 19: Open template dialog*

2. **In the Templates box, select the template you want to open, and then click Open.**
   
   The following dialog appears:

   ![Overwrite current tool data dialog](image)

   *Figure 20: Overwrite current tool data dialog*
3 Click Yes.

The template data is loaded.

If you instead click No, the opening of the template is interrupted and the old data is kept in the tool.

Note!

A template cannot be copied or moved to another project or computer. Use Compressed files instead when the data for a terminal instance need to be copied.

You cannot open a template for a different terminal module than the one that you are working with. In the Open template dialog, figure 19, you will only see the templates for the current terminal module.

The templates in PST and CAP 531 are handled separately. That is, the templates in PST covers only the parameters for a terminal, not the configuration.

19.7 Open a compressed file

Before you can open a compressed file there must exist a compressed file. The file is created by the Compress command on the File menu, or the file is copied from another project or computer.

You can open a compressed file that has been saved earlier. Compressed files stores the PST values for an entire terminal instance. The terminal values are not stored. Compressed files can be moved to other projects or computers. The file extension is.zpt.

1 On the File menu, click Decompress.

The following dialog appears:

![Decompress file dialog](image)

Figure 21: Decompress file dialog
Only files with the extension.zpt are visible.

2 **Select the folder and the file name of the file you want to decompress, and then click Decompress.**

The following dialog appears:

![Figure 22: Overwrite current tool data dialog](image)

3 **Click Yes.**

The data from the compressed file is loaded.

If you instead click No, the opening of the compressed file is interrupted and the old data is kept in the tool.

**Note!**

It is not possible to decompress a file that was compressed for a different terminal type than the one that you are working with. If you do so anyway, you will get an error message and the Decompress command will be cancelled.

19.8 **Off-line adjustment of terminal options**

For efficient off-line engineering it is possible to adjust the function library to exact reflect the functions delivered in the terminal without having to upload options from the terminal.

![Figure 23: Menu for off-line adjustment of terminal option](image)

In the next dialog select the opf-file corresponding to the terminal.
19.9 Navigate in the terminal tree

You can select different levels in the terminal tree depending on which parameters you want to change. You select levels by double-clicking the level icons or by clicking the plus and minus signs in front of the level icon in the tree.

1 Point on a level in the terminal tree that you want to expand, and then double-click.

You can also click the plus sign in front of the level icon

Continue to expand the levels until you reach your wanted parameter level. The parameters are then presented in the parameter view window.

19.10 Change a parameter value

Before you can change any parameter values you must have navigated to a parameter level in the terminal tree.

You can change the value of a parameter by entering new values in the parameter input fields in the parameter view.

There are two types of input fields:

- writable boxes
- lists of predefined values.

For a parameter that has a writable box:

1 Type the new parameter value in the box.

The new value appears in bold blue.

If you enter illegal values such as values outside ranges, wrong step or wrong format, you get an error message and the illegal value is highlighted. Now you can enter a valid value for the parameter. CTRL + Z will bring back the old value.

For a parameter that has a list of predefined values:

1 Click the arrow of the list.

All predefined values are shown, see example in figure 24.

Figure 24: Example of opened list in the parameter view.
2 In the list, click a value of your choice.

The value is selected as the new parameter value and appears in bold blue.

19.11 Save the parameter values

You need to save the values you have changed in order to make them available for the tool.

You can do this in two ways:

- by a menu command
- from the tool bar.

To save the parameters by a menu command:

1 On the File menu, click Save

All changed values are saved in PST. The parameter values that was marked changed with bold blue, are now presented with normal style.

To save the parameters from the tool bar:

1 On the tool bar, click Save.

All changed values are saved in PST. The parameter values that was marked changed with bold blue, are now presented with normal style.

Note!

There are no menu commands to discard changed values. If you try to exit the tool, try to copy setting groups or view differences, without saving the changed values, you get a dialog in which you can select to save the changes or discard them.

![Save the changed values dialog](image)

Figure 25: Save the changed values dialog.
19.12 Work with setting groups

This section describes how you work with setting groups. You can select which group you want to work with. Only one setting group at the time can be viewed. You can also copy all parameter values from one setting group to another. How to print parameter values from various setting groups is described in section 23.

19.12.1 Select setting group

You can select which setting group you want view in two ways:

- by a menu command
- from the tool bar.

To select the setting group by a menu command:

1 On the View menu, click Setting Group

The following dialog appears:

![View Setting Group dialog](image)

*Figure 26: View setting group dialog*

2 In the Setting Group box, type or select the setting group you want to view, and then click OK.

The parameter values of the selected setting group are shown in the parameter view, whenever the terminal tree is browsed, until you change to another setting group.

To select the setting group from the tool bar:

1 On the tool bar, in the Setting Group box, type or select the setting group you want to view.

The parameter values of the selected setting group are shown in the parameter view, whenever the terminal tree is browsed, until you change to another setting group.

**Note!**

You cannot perform any setting group actions for parameter levels that do not belong to setting groups.
19.12.2  

Copy values between setting groups
You can copy all parameter values from the selected setting group to another.

1  On the Edit menu, click Copy Settings
The following dialog appears:

![Copy Setting Group dialog](image)

*Figure 27: Copy setting group dialog*

2  In the Destination box, type or select the setting group(s) you want to copy to, and then click OK.

All parameter values are now copied to the new setting group(s).

**Note!**
If you try to copy the values to another setting group without saving the changed values, you get a dialog in which you can select to save the changes or discard them.

![Save the changed values dialog](image)

*Figure 28: Save the changed values dialog.*

20  

Read parameter values from a terminal

This section describes how to read parameter values from a terminal. All parameter values or a selection of parameters can be read.

To read parameter values from a terminal, the communication parameters must be set up according to section 19.2 and there must be a physical connection to your terminal.
20.1 Read options

For products in the REx5xx series of terminals, the functionality of the terminal is controlled by options. Example of this are the various protective functions, the I/O boards, etc. Which parameters you can see in PST will then consequently be controlled by the options.

When parameter is read from the terminal for the first time, the options are also read, see section 20.2. In all the following readings from the terminal, the options will not be read. The options will also be read when you write any parameter to the terminal without ever before having read the parameters from the terminal. In both of these cases, the following dialog appears:

![Figure 29: Read options dialog](image)

If the functionality (options) of your terminal are changed after you have read the parameter once, you must manually read these options, or else there will most likely be errors when reading and writing parameters.

1 On the Online menu, click Read Options

The functionality available in the PST is now adapted to the functionality (options) in the terminal.

20.2 Read all parameter values

This section describes how to read all parameter values from a terminal.

1 On the Online menu, point to Read from Terminal, and then click All.

All PST values are read from the terminal to the Terminal value fields in PST.

For option handling in the REx5xx series of terminals see section 21.

20.3 Read selected parameter values

This section describes how to read a selected part of parameter values from a terminal.
1 Select a parameter level in the terminal tree

All parameter values under this level form the selection. If the parameters under this level is part of setting groups, only parameters in the selected group are included in the selection.

2 Do one of the following:

- On the Online menu, point to Read from Terminal, and then click Selection.
- On the tool bar, click Read from Terminal | Selection

The selected part of parameter values are read from the terminal to the Terminal value fields in PST. If the check box ‘Replace PST values when reading from terminal’ is selected in the customize dialog, see section 19, also the PST value fields are updated with the values read from the terminal.

For option handling in the REx5xx series of terminals see section 21.

20.4 Read dialog

This section describes the functionality of the dialog after the parameters are uploaded to the PC. After the communication with the terminal is finished the user is presented the following dialog box:

Figure 30: Dialog box after parameters have been uploaded.

After the parameters are uploaded the user has the following choices: Save, compare and cancel. Save will write the uploaded parameters to the PST values on the PC. Compare will make a comparison between the uploaded parameters and the corresponding PST values on the PC. Cancel will leave the uploaded parameters in the terminal value column with no further action.

20.5 Save last read

If the user select compare or cancel there is still a possibility to save the last read parameters to the PST values without uploading one more time. Under file on the menu select Save last read, and the PST values are updated with the uploaded values.
Compare tool parameter values with terminal values

This section describes how to compare parameter values in the terminal and in PST, and how to view differences between the Terminal value fields and the PST value fields in the tool.

21.1 Compare with terminal

You can compare the parameter values in the terminal and in the tool. To compare parameter values, the communication parameters must be set up and a physical connection to your terminal must be available. You can compare the parameters in three ways:

- After upload of terminal values
- by a menu command
- from the tool bar.

To compare parameters by a menu command:

1 On the Online menu, click Compare with Terminal.

All parameter values are read from the terminal to the Terminal value fields in the tool. Then the command ‘View Differences’ starts automatically, see section 21.2 . For option handling in the REx5xx series of terminals, see section 21 .

To compare parameters from the tool bar:
1 On the tool bar, click Compare with Terminal

All parameter values are read from the terminal to the Terminal value fields in the tool. Then the command ‘View Differences’ starts automatically, see section 21.2.

For option handling in the REx5xx series of terminals, see section 21.

21.2 View differences

You can view the differences between the Terminal value fields and the PST value fields. This command can be manually started, but it also starts automatically from the ‘Compare with Terminal’ command.

Note!

The view differences command doesn’t read parameter values from the terminal. If you want to read from the terminal, please use ‘Compare with Terminal’, or ‘Read from Terminal|All’ instead.

1 On the View menu, click Differences.

The following window appears:

Figure 32: Differences window

For every parameter for every setting group that are not equal in the Terminal value field and in the PST value field, there is a line presented in the window, and the number of differences are shown in the status bar. No differences are indicated by the fact that there are no lines at all in the window, and the number of differences in the status bar says zero.
Note!

If you select to view the differences without saving the changed values, you get a
dialog in which you can select to save or discard the changes before the differences are
calculated. You can also select to cancel the Differences command.

21.2.1

Print differences

You can print the differences.

1 In the Differences window, on the File menu, click Print.
   The following dialog appears:

2 In the Name box, select the printer you want to use, and then click OK.

Save differences on a file

You can save the differences on a file. The items in the file are semicolon(;) separated.

1 In the Differences window, on the File menu, click Save.
   The following dialog appears:
Compare tool parameter values with terminal

How to use PST

2 Select the folder and the name of the file you want to save the differences in, and then click Save.

The saved file can be opened by for instance Microsoft Excel, See “Open a printed file with Microsoft Excel” on page 65.

Figure 35: Save the changed values dialog
22 Write parameter values to a terminal

This section describes how to write parameter values to a terminal. All parameter values or a selection of parameters can be written. To write parameter values to a terminal, the communication parameters must be set up and a physical connection to your terminal must be established.

22.1 Write all parameter values

You can write all parameter values to a terminal.

1 On the Online menu, point to Write to Terminal, and then click All.

The following dialog appears:

![Write to terminal warning dialog](image)

Figure 36: Write to terminal warning dialog

2 Click Yes

The changed values are saved in tool and the writing to the terminal starts.

If you instead click Cancel, the Write to Terminal command will be cancelled.

If the check box “Read back values after a Write to Terminal” is selected in the customize dialog, there will be a read back of the parameter values from the terminal to the Terminal value fields in the tool, after they are written to the terminal.

For option handling in the REx5xx series of terminals see section 21.

3 Special handling of MIM and AIM changes in RET 521

After a change of parameters for mA Input Module (MIM) or Analogue Input Module (AIM) in RET 521*2.0, 2.1 and 3.0, the respective MIM and AIM parameters must be saved with a write selection command, write all does not activate settings on the MIM and AIM.
22.2 Write selected parameter values to the terminal

You can write a selected part of the parameter values to the terminal.

1 Select a parameter level in the terminal tree

All parameter values under this level forms the selection. If the parameters under this level is part of setting groups, only parameters in the selected setting group are included in the selection.

2 Do one of the following:
   - On the Online menu, point to Write to Terminal, and then click Selection.
   - On the tool bar, click Write to Terminal | Selection.

The following dialog appears:

Figure 37: Write to terminal | Selection dialog

Figure 38: Write to terminal warning dialog
3 **Click Yes.**

The changed values are saved in the PST and the writing to the terminal starts.

If you click Cancel, the Write to Terminal command will be cancelled.

If the check box “Read back values after a Write to Terminal” is selected in the customize dialog, there will be a read back of the parameter values from the terminal to the Terminal value fields in the tool, after they are written to the terminal. Only the selected parameters that were written, are read back.

For option handling in the REx5xx series of terminals see section 21.
23 Print parameters

This section describes how to print the parameters.

Start by changing the header and footer information of the printout to suit your project and organization. Then you can choose to print the parameters on a printer or to a file. You can print all parameters for a terminal instance or a selected part of the parameters.

23.1 Change the header and footer information

You can change the information in the header and in the footer of your printout.

1 On the File menu, click Print.

The print dialog appears:

![The print dialog]

*Figure 39: The print dialog*

23.1.1 Value Selection

The user can choose to print PST values, terminal values or both, by choosing either "Terminal values" or "PST values" below Value Selection. Notice that at least one option has to be checked.
23.1.2 Font
When only one setting group is checked a larger font is used for printing.

1 Click Header/Footer
The following dialog appears:

![Figure 40: Header/Footer information dialog](image)

The boxes in the footer area have the same names as you see them in the printout, see figure 43.

The maximum number of characters for each item is also indicated in the figure.

2 Type new values in the boxes.
3 If you want to add another bitmap to your printout, click Browse in front of the BMP file box.

The following dialog appears:

![Bitmap dialog](image)

*Figure 41: Insert bitmap dialog*

The bitmap can for instance be your company logotype. The bitmap appears in the lower left corner of the printout, to the left of the ‘Company name’, see figure 43.

Use a graphical tool like Microsoft Paint®, if you want to create a new bitmap file.

4 Select the folder and the file name of the file you want to be your bitmap file, and click OK.

5 Click OK in the Header/Footer information dialog

The changed header and footer information will now be used for your printouts for this terminal instance.

**Note!**

*Terminal instance specific information is automatically printed on the first sheet of your printout, see figure 43.*

**Note!**

*The layout of the printouts is predefined and cannot be changed by the user. Only the header and footer information can be adapted.*
23.2 Print to a printer

You can print the parameters on a printer.

There are two ways to do this:

- by a menu command
- in the tool bar.

23.2.1 Print to a printer by a menu command

You can print the parameters on a printer by a menu command.

1 On the file menu, click Print.

The print dialog appears:

![Print dialog](image)

*Figure 42: The print dialog*

Value selection

The user can choose to print PST values, terminal values or both, by choosing either "Terminal values" or "PST values" below Value Selection. Notice that at least one option has to be checked.

Font

When only one setting group is checked a larger font is used for printing.
Make sure that the information in the header and footer are valid, see section 23.1, before you start to print.

2 In the Name box, select the printer you want to use.

3 Do one of the following:
   - To print all parameters, click All in the Print range area.
   - To print a selection of parameters, click Selection in the Print range area. Activate then the main window of the tool, and select a level in the terminal tree.
     - All parameters under that level will be printed.
     - You can also select the level in the terminal tree before you start the print command.

4 In the Setting Groups area, select the appropriate check boxes for the setting groups you want to print.

5 In the Value Selection area, select the appropriate check boxes for the values you want to print.

6 In the Number of copies box, type or select how many copies you want to print, and then click OK.

The printout starts. An example of a printout is found here:

![Parameter Setting Tool](image)

**Figure 43: Example of a printout**
23.2.2 Print to a printer from the tool bar

You can print the parameters on a printer from the tool bar.

1 Select a level in the terminal tree.
   All parameters under that level will be printed.

2 On the tool bar, click Print
   The printout starts, using the last entered values for:
   - printer name
   - number of copies
   - setting groups
   - header/footer item values

   in the print dialog (figure 42).

   See figure 43 for an example of a printout.

23.3 Print to a file

You can print the parameters to a file. The items in the file are tabulator separated.

1 On the File menu, click Print.
   The print dialog appears, see figure 42.

2 Click Print to file, and then click Browse.
   The following dialog appears:

   ![Figure 44: Print to file dialog](image)
3 Select the folder and the name of the file you want to print to and click OK.
   The file extension .txt is used. If you omit the file extension, it will automatically be set to .txt.

4 Do one of the following:
   • To print all parameters, click All in the Print range area.
   • To print a selection of parameters, click Selection in the Print range area.
     Activate the main window of the tool, and select a level in the terminal tree.
     - All parameters under that level will be printed.
     - You can also select the level in the terminal tree before you start the print command.

5 In the Setting Groups area, select the appropriate check boxes for the setting groups you want to print.

6 In the Value Selection area, select the appropriate check boxes for the values you want to print.

7 Click OK
   The parameters are printed to the file with a tabulator separation mark. The terminal instance specific parameters are put first, then the header and footer information and the parameters. You can open the file with e.g. Microsoft Excel.

23.3.1 Open a printed file with Microsoft Excel
   You can open a printed file in Microsoft Excel

1 Start Microsoft Excel.

2 On the File menu click Open and select the file you want to open.
   The Text Import Wizard is started.
Save parameter values for an entire terminal instance

This section describes how the parameter values for a terminal instance can be saved as a template or as a compressed file.

This section does not describe the saving of changed parameters on one level in the terminal tree. Information on this is found in section 19.11 “Save the parameter values”

24.1 Save as a template

You can save the parameter values for a terminal instance as a template. The template can later be used for a quick-start when editing other terminal instances in your project. Templates store the setting values for an entire terminal.

1 On the File menu, point to Template, and then click Save.

The following dialog appears:

Figure 45: Microsoft Excel Text Import Wizard

3 Click Finish
Save parameter values for an entire terminal

2 In the Template name box, type or select the name.
3 In the Description box, type your description, and then click OK.

The parameter values for your terminal instance are now saved as a template.

Note!
A template cannot be copied or moved to another computer. Use Compressed files instead when the data for a terminal instance need to be copied.

The templates in PST and CAP 531 are handled separately. The templates in PST covers only the parameters of a terminal and not the configuration.

If you try to save the parameter values as a template without saving the changed values, you get a dialog in which you can select to save the changes or discard them.

24.2 Save as a compressed file

You can save the parameter values for a terminal instance as a compressed file. Compressed files can be copied or moved to other projects or computers. Compressed files store the parameter values for an entire terminal instance.

1 On the File menu, click Compress.

The following dialog appears:
Save parameter values for an entire terminal

How to use PST

1MRK 511 089-UEN*1.1-02

Figure 48: Compress file dialog

2 Select the folder and the File name of the file you want to compress, and then click Save.

You can only save compressed file with the extension.zpt. If you omit the extension in the file name, it will automatically be set to.zpt.

The parameter values for your terminal instance are now saved as a compressed file.

Note!
If you try to save the parameter values as a compressed file without saving the changed values, you get a dialog where you can select to save the changes or discard them.

Figure 49: Save the changed values dialog.
Exit PST

This section describes how to exit PST.

1 **On the File menu, click Exit.**

   An alternative way to exit is to press the Close button in the upper-right corner of the main window.

   The parameter tool exits for this terminal instance. The parameter values are remembered by the terminal instance until the next time it is started.

**Note!**

*If you try to exit without saving the changed values, you get a dialog in which you can select to save the changes or discard them.*

![Figure 50: Save the changed values dialog.](image)

Process Terminator

Sometimes when shutting down PST and CAP531 some processes (program parts) are still running. These remaining processes are interfering the behavior of PST and CAP531 the next time these are started. To be able to shutdown these remaining processes, PST is provided with a small application called Process Terminator. The shutdown is straightforward which means that after clicking the Terminate button there are no point of return regarding unsaved data.
Process Terminator

How to use PST

The application works like the Task Manager in Windows NT with the limitation to only effect the processes related to PST and CAP531. The GUI comprise of a list presentation of the currently remaining processes related to PST and/or CAP531, three buttons (Shutdown, Refresh and Exit) and a status bar showing current date, current operating system version and running mode. The title bar is also showing the name of the PC.

1 Start-up Process terminator

To start ProcTerm.Exe proceed according to following:

An alternative way is to select Program -> PST -> Terminate CAP 535 processes.

Figure 51: Process Terminator - CAP531 and PST process terminator

Figure 52: Process Terminator - How to find and start
2 Process Terminator functionality

When ProcTerm.Exe is started the first appearance is according to the figure below. The appearance is modifiable by resizing the dialog, resizing column widths and sort order. Sort order is changed by clicking on the column header of the list.

Performing shutdown of the listed processes is made by clicking on the Terminate all button. After this is completed the following message is displayed.

After the Refresh button has been clicked appearance is as following, note that Terminate all button is dimmed.
3 Windows NT specific behavior

Windows NT executes 16-bit programs in a specific way. There is a special process called NTVDM.EXE which handles all 16-bit programs. When the Process Terminator shuts down CAP 531 and PST programs it also looks for the NTVDM.EXE process to be able to shutdown CAP 531 which is a 16-bit program. Because other 16-bit programs may be running the shutdown of the NTVDM.EXE program is prompted.

At this point there is a possibility to skip, by selecting No in the message box, the termination of the remaining CAP 531 processes and save unsaved data for the other 16-bit programs. After this return back to the Process Terminator to repeat the shutdown.
Process Terminator

How to use PST
Graphical User Interface (GUI)

Main window ...................................................................................................... 79
Terminal tree ...................................................................................................... 80
Parameter view................................................................................................ 81
  Special parameter view................................................................................... 82
Menus .................................................................................................................. 83
  File menu ....................................................................................................... 83
  Edit menu ...................................................................................................... 84
  View menu .................................................................................................... 84
  Online menu .................................................................................................. 85
  Help menu ..................................................................................................... 86
Tool bar ............................................................................................................... 87

Differences window ............................................................................................ 87
Menus .................................................................................................................. 88
  File menu ....................................................................................................... 88
  Help menu .................................................................................................... 88

Help ..................................................................................................................... 88
Graphical User Interface (GUI)

This chapter describes the graphical user interface of the PST. It explains the different parts such as the windows, the menus, the tool bar and the status bar. It also defines the names for the parts in the user interface, that are used throughout this manual.

The Main window and the Differences window are described in this chapter.

Main window

When the parameter tool starts the main window according to figure 57 appears. At top of this window there is a title bar, a menu bar and a tool bar. At left there is a browsing sub-window called the Terminal Tree and at right there is a presentation sub-window called the Parameter View. At the bottom there is a status bar.
27.1 Terminal tree

Shows the structure in which the parameters for a terminal instance are organized. The folders can be expanded and collapsed by double-clicking them or by clicking on the plus and minus signs in front of the folder icon.

Figure 58: The levels in the terminal tree

Table 9: Icons in the terminal tree

<table>
<thead>
<tr>
<th>Icon</th>
<th>Represents...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The terminal instance</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A closed terminal sub level</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>An opened terminal sub level.</td>
</tr>
</tbody>
</table>
27.2 Parameter view

When the terminal level or a terminal sub-level is selected in the terminal tree, the contents of that level are shown in the parameter view to the right. When you double-click a level in the parameter view, you will see its contents. You can continue to double-click levels until a list of parameters is shown.

When a parameter level is selected in the terminal tree, a list of parameters is shown, see figure 57. For each parameter you will see its name, its value in the terminal, its value in PST and the unit. The terminal value field is empty if the parameters never have been read from the terminal - otherwise the values originate from the last time they were read from the terminal. The terminal value fields are also updated when writing to the terminal when the flag “Read back all values after a Write to Terminal” is set.

You can change the parameter value by editing input fields of the PST Values. A changed value is shown in bold and in the color blue, see figure 59.

Moving the cursor over a parameter name, results in a tool tip with a description of the parameter. Moving the cursor over the parameter input field, results in a tool tip with information on the ranges and steps for the parameter in question.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Represents...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>A closed configuration parameter level</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>An opened configuration parameter level</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>A closed setting parameter level</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>An open setting parameter level</td>
</tr>
</tbody>
</table>

Table 9: Icons in the terminal tree (Continued)
If the values do not fit in a Terminal Value field, you get ... (three dots) presented to the right of the field. Moving the cursor over the field, results in that the whole value is presented as shown in the figure below.

Figure 59: Parameter view with changed values and tool tips

If the values do not fit in a Terminal Value field, you get ... (three dots) presented to the right of the field. Moving the cursor over the field, results in that the whole value is presented as shown in the figure below.

Figure 60: Presentation of large Terminal values

27.2.1 Special parameter view

For Internal Events in the terminal families REX500 and RET521, the parameters are presented in a different way than the default one. This is shown in the figure below.

Figure 61: Parameter view for Internal Events.
27.3 Menus

This chapter describes briefly all menus and the commands in them. The detailed usage of the commands are described in chapter “How to use PST”.

27.3.1 File menu

Table 10: File menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>![Button]</td>
<td>&lt;CTRL&gt; + S</td>
<td>Save all the changes you have made.</td>
</tr>
<tr>
<td>Save latest read</td>
<td></td>
<td></td>
<td>Save the latest uploaded terminal values to the PST values</td>
</tr>
<tr>
<td>Compress</td>
<td></td>
<td></td>
<td>Save the terminal instance as a compressed file.</td>
</tr>
<tr>
<td>Decompress</td>
<td></td>
<td></td>
<td>Open a compressed file for a terminal instance.</td>
</tr>
<tr>
<td>Template - Save</td>
<td></td>
<td></td>
<td>Save the terminal instance as a template.</td>
</tr>
<tr>
<td>Template - Open</td>
<td></td>
<td></td>
<td>Open a template for a terminal instance.</td>
</tr>
<tr>
<td>Print...</td>
<td>![Button]</td>
<td>&lt;CTRL&gt; + P</td>
<td>Print the parameters.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td>Exit PST</td>
</tr>
</tbody>
</table>
27.3.2 Edit menu

![Edit menu screenshot]

Figure 63: Edit menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Settings</td>
<td></td>
<td></td>
<td>Copy parameter values from one setting group to another.</td>
</tr>
<tr>
<td>Customize</td>
<td></td>
<td></td>
<td>Customize the behavior of PST.</td>
</tr>
<tr>
<td>Terminal options</td>
<td></td>
<td></td>
<td>Import terminal options from file in order to adjust function library for efficient off-line engineering</td>
</tr>
</tbody>
</table>

27.3.3 View menu

![View menu screenshot]

Figure 64: View menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool bar</td>
<td></td>
<td>&lt;F5&gt;</td>
<td>Show or hide the tool bar.</td>
</tr>
<tr>
<td>Differences</td>
<td></td>
<td></td>
<td>Show the differences between the parameter values in the tool and the values earlier read from the terminal.</td>
</tr>
<tr>
<td>Setting Group</td>
<td></td>
<td></td>
<td>View another setting group</td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
<td>&lt;F5&gt;</td>
<td>Redraws the PST window</td>
</tr>
</tbody>
</table>
27.3.4 Online menu

Figure 65: Online menu
Table 13: Online menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read From Terminal</td>
<td></td>
<td></td>
<td>Read all parameter values from the terminal.</td>
</tr>
<tr>
<td>Read from Terminal</td>
<td></td>
<td></td>
<td>Read the parameter values under the selected level, from the terminal</td>
</tr>
<tr>
<td>Write to Terminal</td>
<td></td>
<td></td>
<td>Write all parameter values to the terminal.</td>
</tr>
<tr>
<td>Write to Terminal</td>
<td></td>
<td></td>
<td>Write parameter values under the selected level in the terminal tree, to the terminal.</td>
</tr>
<tr>
<td>Read Options</td>
<td></td>
<td></td>
<td>Read the options from the terminal. (Only visible when the terminal family supports options)</td>
</tr>
<tr>
<td>Compare with Terminal</td>
<td></td>
<td></td>
<td>Compare the parameter values in the tool and in the terminal. At first, this command reads the parameter values from the terminal</td>
</tr>
<tr>
<td>Setup</td>
<td></td>
<td></td>
<td>Setup the communication parameters</td>
</tr>
</tbody>
</table>

27.3.5

Help menu

![Help menu](image)

*Figure 66: Help menu*

Table 14: Help menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and index.</td>
<td></td>
<td></td>
<td>Start Help for PST</td>
</tr>
<tr>
<td>About PST</td>
<td></td>
<td></td>
<td>Get information on tool and module versions.</td>
</tr>
</tbody>
</table>
27.4 **Tool bar**

The functions in the tool bar are explained in figure 67.

*Figure 67: Tool bar*

If you move the cursor over the items in the tool bar you get a tool tip.

28 **Differences window**

When you select ‘Differences’ in the ‘View’ menu or ‘Compare with Terminal’ in the ‘Online’ menu in the main window, the following window appears:

*Figure 68: Differences window*

For every parameter for every setting group that not are equal in the Terminal value field and in the PST value field, a line is presented in the window. The lines are organized with headlines who represent the parameter levels in the terminal tree.

The status bar shows how many differences that were found.
Help

28.1 Menus

This section describes briefly all menus and commands in the Differences window.

The detailed usage of the commands are described in section 21.2 “View differences”.

28.1.1 File menu

Figure 69: Differences file menu

Table 15: Differences file menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td>Save the differences as semicolon(;) separated file.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td>Print the differences.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td>Exit the differences window</td>
</tr>
</tbody>
</table>

28.1.2 Help menu

There is only one command in the Help menu that starts when clicking at the help item in the menu bar:

Table 16: Differences help command

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and index</td>
<td></td>
<td></td>
<td>Start the help page for the Differences window.</td>
</tr>
</tbody>
</table>

29 Help

This section describes how you get help on using the tool and how you get help on the parameters.

You can also start the help system by clicking Contents and index on the Help menu, as well as from the tool bar button and then find your topic in the index or by browsing for it in the help structure.
To get help on a parameter, move the cursor over the parameter name in the parameter view, and you will get a tool tip with description of the parameter in question. Instead, if moving the cursor over the input field, you get a tool tip with information on ranges and steps of the parameter.
System errors and messages

This chapter explains errors and messages and gives you hints what to do if they occur.

Table 17: System errors and messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addressed data impossible to read or write.</td>
<td>Addressed data impossible to read or write due to a permanent or temporary blockade.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Checksum or parity error.</td>
<td>Error in the checksum or parity of the data send to the terminal.</td>
<td>Restart your PC and try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Connect DDE failed.</td>
<td>Failed to establish a DDE connection between Communication object and SPA Bus.</td>
<td>Restart PST and try again and if you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Data in write message is not validated.</td>
<td>Format of the data in write message is not validated.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Failed to start SPABus.exe.</td>
<td>Starting of SPABus Failed.</td>
<td>Restart PST and try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Message too complicated for terminal.</td>
<td>Message from master is too complicated for the terminal.</td>
<td>Make a new instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Registry error.</td>
<td>An error related to setting or getting data from registry.</td>
<td>Delete the terminal from the navigator, make a new terminal and then try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Serial Number does not match.</td>
<td>The serial number received from the terminal does not match with the serial number of the previous terminal communication.</td>
<td>Try again and if you get a message that ask you about overwriting the current serial number, answer Yes.</td>
</tr>
<tr>
<td>Slave is busy.</td>
<td>The terminal is currently busy with another job.</td>
<td>Wait a short while and try again.Restart the terminal if you still have the problem.</td>
</tr>
<tr>
<td>Syntax error.</td>
<td>Incorrect or unrecognized message type.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
</tbody>
</table>
## Table 17: System errors and messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Type does not match.</td>
<td>The PST module and the terminal to communicate have different types.</td>
<td>Check that you have selected right type of terminal when you created the instance. If the problem remains delete the terminal from the navigator and make a new instance, make sure that you select the right type of terminal. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>The terminal do not contain all data requested in message.</td>
<td>Terminal does not contain all data requested in the message.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Time out.</td>
<td>No response from the terminal.</td>
<td>Check the communication parameters and restart the PST. If you still have the problem restart the terminal and PST.</td>
</tr>
<tr>
<td>Undefined negative acknowledgment.</td>
<td>Undefined negative acknowledgment, it can be an internal error in communication program.</td>
<td>Restart PST and try again and if you still have the problem, call for technical support on PST.</td>
</tr>
</tbody>
</table>
ABB Automation Products AB would appreciate your comments on this product. Please grade the following questions by selecting one alternative per category. Your answer will enable us to improve our products.

**How do you grade the quality of the product?**

<table>
<thead>
<tr>
<th>Category</th>
<th>Excellent</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total impression</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Useability</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human-machine interface</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comments: __________________________________________________________
____________________________________________________________________
____________________________________________________________________

**How do you grade the quality of the documentation?**

<table>
<thead>
<tr>
<th>Category</th>
<th>Excellent</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total impression</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Illustrations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Readability</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Easy to find</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content structure</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comments: __________________________________________________________
____________________________________________________________________
____________________________________________________________________
Customer feedback report

Suggestions for improvements:
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

Please send this report to:
ABB Automation Products AB
Substation Automation Division
SA-T, Support Line
SE-721 59 Västerås
Sweden

By facsimile:
Send to + 46 21 14 69 18
Program:

This card registers your program and makes you eligible to receive information about future updates.

Name:____________________________________________________________________________________

Title:____________________________________________________________________________________

Company:____________________________________________________________________________________

Dept.:____________________________________________________________________________________

Address:____________________________________________________________________________________

____________________________________________________________________________________

City:____________________________________________________________________________________

State:____________________________________________________________________________________

Zip:____________________________________________________________________________________

Phone:____________________________________________________________________________________

Fax:____________________________________________________________________________________

Program supplied by:_____________________________________________________________________

Adress:____________________________________________________________________________________

____________________________________________________________________________________

City:____________________________________________________________________________________

State:____________________________________________________________________________________

Zip:____________________________________________________________________________________

Phone:____________________________________________________________________________________

Date of receipt of the program:_____________________________________________________________________

Program serial Nr:_____________________________________________________________________

Fascimile:

Please send this registration card to ABB Automation Products AB, Sweden department Substation Automation, SA-T, Support Line (+46 21 14 69 18)
IMPORTANT - READ CAREFULLY BEFORE OPENING

This legal document is an agreement between You, the user, and ABB Automation Products AB, Västerås, SWEDEN. By opening the diskette package You indicate your acceptance of the terms and conditions of this agreement. If You do not agree to the terms of this agreement, promptly return the unopened diskette package and other items which are part of the product for a full refund. Your product is a single user version unless you have a written agreement with ABB Automation Products AB.

SOFTWARE LICENSE

1. Grant of License
   • This ABB Automation Products AB License Agreement (“License”) grants you the nonexclusive right to use one copy of the enclosed software program (“SOFTWARE”) on a single computer (i.e., with a single CPU) at a single location at any time. If you have multiple Licenses for the SOFTWARE you may have as many copies of the SOFTWARE in use as you have Licenses.

2. Copyright
   • The software is owned by ABB Automation Products AB or its suppliers and is protected by Swedish copyright laws, international treaty provisions, and all other applicable national laws. Therefore you must treat the SOFTWARE as any other copyrighted material (e.g., a book or musical recording) except that if the software is not copy protected you may either (a) make a copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the Documentation accompanying the SOFTWARE.

3. Term
   • The License is effective until terminated. This License will terminate automatically without notice from ABB Automation Products AB if you fail to comply with any provision of this License. Upon termination you shall return the diskettes containing the SOFTWARE and all Documentation to ABB Automation Products AB and destroy any copies of the SOFTWARE or any portions of it which has not been returned to ABB Automation Products AB, including copies resident in computer memory.

4. Other Restrictions
   • You may not rent, lease, lend, sell or give away the SOFTWARE, but you may transfer your rights under this ABB Automation Products AB License Agreement on a permanent basis provided you transfer all copies of the SOFTWARE and all written materials, and the recipient agrees to the terms of this Agreement. You may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the SOFTWARE. You may not modify, adapt, translate or create derivative works based on the written materials.

LIMITED WARRANTY

Limited Warranty
   • ABB Automation Products AB warrants that the software will perform substantially in accordance with the accompanying Product Manual(s) for a period of 1 year from the date of delivery from ABB Automation Products AB, Västerås. ABB Automation Products AB does not warrant that the SOFTWARE is free from coding errors.

Customer Remedies
   • ABB Automation Products AB’s entire liability and your exclusive remedy shall be, at ABB Automation Products AB’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet ABB Automation Products AB’s Limited Warranty and which is returned to ABB Automation Products AB with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

No Other Warranties
   • ABB Automation Products AB disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the SOFTWARE, accompanying Product Manual(s) and written materials. This warranty gives you specific legal rights.

No Liability for Consequential Damages
   • Neither ABB Automation Products AB nor anyone else who has been involved in the creation, production or delivery of this product shall be liable for any direct, indirect, consequential or incidental damages (including damages for loss of business profits, business interruption, loss of business information, and the like) arising out of the use or inability to use such product even if ABB Automation Products AB has been advised of the possibility of such damages. In any case, ABB Automation Products AB’s entire liability under any provision of this agreement shall be limited to the amount actually paid by you for the software.

ACKNOWLEDGEMENT

By opening the diskette package you acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and conditions. You also agree that it is the complete and exclusive statement of the agreement between the parties and supersedes all proposals or prior agreement, oral or written, and any other communications between the parties relating to the subject matter of the licence or limited warranty.

This Agreement is governed in all aspects by Swedish law. If any provisions of this Agreement are invalid or unenforceable, all others will remain in effect.